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Abstract. As the luminance range in nature covers about 10 orders of absolute intervals  and  the simple systems 

for 8 bits per pixel per band of the digital images sensors, and display and printing only cover two orders may be 

lost many details that are in very bright or very dark areas. For this reason modern photogrammetric cameras and 

satellite images of high geometric resolution are using 12 or 16 bits. But when is to view images of higher 

radiometric resolution using the 8-bit devices via remote sensing programs an automatic contrast enhancement 

occurs that can change both the balance between bright and dark areas and details are lost, but also the general 

appearance of hue. This article uses images ADS-80 camera presents problems mentioned and shows the results 

of application functions that perform the appropriate contrast operations. The functions tested were those 

existing in Erdas® and Envi® programs and other, ever existing and some implemented, in Matlab. Finally are 

presented the output images of functions used that gave good results. 
 

Palavras-chave: aerial photogrammetry, image processing, high dinamic range image, aerofotogrametria, 

processamento de imagens, imagem de alto contraste.  

 

1. Introdução  

 A resolução radiométrica comum de 8 bits, que corresponde aos níveis de cinza 

registrados nos valores 0-255 muitas vezes são insuficientes, porque o intervalo de luminância 

que ocorre no mundo real é vasto: cobre aproximadamente 10 ordens de intervalos absolutos, 

do céu totalmente escuro até à neve sob o sol; e de quatro ordens da sombra até os pontos 

mais luminosos numa cena simples. (Reinhard et. al., 2002). Por este motivo as câmaras 

fotogramétricas digitais e imagens de satélites de alta resolução usam 12 ou 16 bits, 

aumentando significativamente a quantidade dos níveis de uma cena que pode ser registrada 

sem perda de informações. Porém a visualização dessas imagens em monitores produzidos 

apenas para 8 bits, abertas em programas de sensoriamento remoto como o Erdas®,  

ArcGIS®, Envi® ou mesmo em programas gráficos com o Paint Shop Pro® e Adobe 

PhotoShop®, pode não ser satisfatória, por conta de contrastes processados automáticamente 

pelos próprios programas. Além disso a aparência não ideal é transferida quando a imagem é 

convertida para 8 bits se não forem tomados alguns cuidados de processamento. 

 Este artigo avalia as conversões de imagens de 16 para 8 bits da câmera ADS-80 com os  

programas comerciais Erdas® e Envi® e com algoritmos de mapeamento de tons com rotinas 

implementadas em Matlab®, com a finalidade de testar e definir os melhores e mais fáceis 

procedimentos que garantam uma conversão adequada. Os resultados são discutidos e 

comparados quanto ao balanceamento obtido entre as zonas mais claras e escuras e tonalidade 

dominante. 

   

2. Metodologia 

 Os recursos usados nesta pesquisa foram imagem da câmera ADS-80 processada com os 

programas Erdas e Envi e com funções e algoritmos em Matlab. Os processamentos 
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permitiram avaliar o balanceamento de iluminação das imagens entre as áreas mais escuras e 

mais claras da imagem de 16 bits, e se foi mantida essa relação nos resultados da conversão 

para 8 bits, que é o formato comum de visualização de imagens nos programas gráficos e  

monitores. 

 

2.1 Imagem de 16 bits/banda da ADS-80 

 A unidade da FAB (Força Aérea Brasileira) 1º/6º GAV, sediada na Base Aérea de Recife- 

PE, é responsável por serviços de levantamentos aerofogramétricos e dispõe de câmeras 

digitais ADS-80 da Leica. Por meio de convênio de cooperação técnico científica com o 

Decart (Departamento de Engenharia Cartográfica) da UFPE, disponibilizas imagens para 

pesquisas como as utilizadas neste trabalho da região de Arapiraca em Alagoas. 

 As imagens ADS são obtidas com 16 bits por banda no sistema de cores RGB e são 

geradas por três imageamentos contínuos e simultâneos, com uma visada para ré, uma nadir e 

outra para vante (Leica, 2011). Uma das faixas, a escolhida para os processamentos desta 

pesquisa é visualizada em 8 bits na Figura 1 (com 10045 x 34816, pixels, girada 90º), na qual 

facilmente são percebidas zonas muitos claras (metade inferior esquerda) e zonas escuras 

(metade da direita).  

 

  
Figura 1. Um segmento de faixa da câmera ADS-80 aberto no Erdas. O retângulo branco 

mostra o recorte usado nos processamentos. (Cortesia do 1º/6º GAV) 

 

 Para facilitar os processamentos foi usado o recorte da imagem marcado na Figura 1. Este 

recorte foi aberto nos programas Erdas, Envi e MultiSpec (Multispec, 2014) e no visualizador 

ER Viewer (Intergraph, 2014). Nos três primeiros o aspecto do recorte entre zonas claras e 

escuras são iguais como mostrado na Figura 2. Neste caso o canto esquerdo ficou muito claro 

e muitos detalhes, como limites de terrenos e calçadas, foram pedidos (Figura 3). O recorte 

aberto no ER Viewer é mostrado na Figura 4, em se percebe um contraste menor entre as 

zonas escuras e claras.   

  

 
Figura 2. Recorte visualizado nos programas Erdas, Envi e MultiSpec de forma automática. 
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Figura 3. Perda de detalhes na área clara da imagem convertida para 8 bits. 

 

 
Figura 4. Recorte visualizado no ER Viewer de  forma automática 

  

 Os histogramas do recorte obtidos com o Envi® das bandas R, G e B são mostrados na 

Figura 5. Os pixels ocupam a parte esquerda do histograma, indicando uma imagem escura e 

não cobrem todo o intervalo 0-65534 que corresponde aos 16 bits. A banda R que tem níveis 

de 0-55186, a banda G que tem níveis 0-5040 enquanto a banda B que apresenta um intervalo 

sensivelmente menor ente os níveis 0-3175, que explica o ton arroxeado da imagem. 

 O motivo das diferenças significativas de tonalidade e brilho vistas na Figura 1 é comum 

e ocorrem na exibição de imagens, de 8 ou 16 bits/pixel/banda, nos softwares de 

sensoriamento remoto, porque elas sofrem automáticamente um aumento de contraste linear 

diferente para cada banda. No Envi a alteração de contraste pode ser identificada e foram: 

para a banda R strech foi entre 594-2244; para a banda G entre 740-2140 e para a banda B  foi 

entre 767-1677. 

 

 
Figura 5. Histogramas da imagem com 16 bits obtidos do ENVI. 

 

2.2 Visualização e processamento 

  Os programas de sensoriamento remoto aplicam uma compressão linear para a 

visualização de imagens de 16 em monitores de 8 bits que difere do modo que a mesma 

imagem é aberta em programas gráficos como o Paint Shop Pro® ou Adobe PhotoShop®. 
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Além disso ocorrem outras diferenças de tonalidades provocadas pelos sistemas de cores 

(Wyszecki e Stiles, 1982) adotados em cada programa. 

 A visualização mais próxima dos tons registrados originais pode ser obtida com a 

manipulação de histogramas nos próprios programas. No Envi, pode ser feito a partir de duas 

sequências: uma começando da função > Basic Tools>Strech Data, quando aparecem as 

opções: a) Linear, b) Equalize, c) Gaussian e d) Square Root, neste caso a imagem resultante 

pode ser salva também com 16 bits. A outra sequência no Envi é processar pela opção via tela 

da imagem:> Enhance>Interactive Stretching> Strech Type com as opções Linear, Piecewise 

Linear, Gaussian, Equalization, Square Root, Arbitrary e User Defined LUT. Após escolhido 

o tipo de stretch a operação continua em Options>Histogram Parametes> Histogram>Aply, 

sendo gerada apenas imagens em 8 bits. Esta operação em cada banda torna as tonalidades da 

imagem mais uniformes entre as zonas claras e escuras (Figura 6). 

  O Erdas ao abrir a imagem de 16 bits também efetua operaçõe similares ao do ENVI e 

alteração de 16 para 8 bits é conseguida com a função o rescale. Também existem dois 

caminhos para o processamento. Um deles começa no grupo Multispectral> General 

Constrast > com as opções: Constant value, Dynamic Range Adjust, Gama, Gaussian, 

Histogram Equalization, Invert, Level Slice, Linear, Min-Max, Percentage LUT e Standard 

Deviations. A outra opção é abrir a aba Raster>Radiometric> Rescale que tem as opções 

Min-Max e Standard Deviations.  

 As opções Linear e Min-Max são ambas lineares e aplicam a compressão pela fórmula: 

 

         
                               

                     
            (1) 

 

Em que: PixelOut, é o nível de cinza ou valor do pixel de saída (8bits); PixelIn, valor do pixel 

de entrada (16bits); MinIn, menor valor da imagem de entrada (16bits); MaxIn, maior valor 

da imagem de entrada (16bits); MinOut, menor valor da imagem de saída (8bits); MaxOut, 

maior valor da imagem de saída (8bits). 

 As funções ou operadores de mapeamento de tons de HDR para visualização em 

monitores de 8 bits são classificados em globais, quanto são aplicados para todos os pixels da 

imagem de entrada e locais, quando tentam reproduzir os contrastes globais e locais. Nesta 

pesquisa foram testados os globais, por serem de mais fácil implementação e uso.  

 As funções de transformações de intensidades no Matlab são: imadjust que pode ser usada 

para transformar de 16 para 8 bits; com sintaxe  j = imadjust(i,[low_in; high_in],[low_out; 

high_out],gamma); stretchlim que encontra os níveis mínimos e máximos da imagem com 

sintaxe [low_high] = stretchlim(i,tol) que retorna um par de valores a ser usado em imadjust 

para aumentar o contraste da imagem (Gonzales et al,2004). As outras funções indicadas em 

Gonzales et al 2004) são a transformação logarítmica e aumento de contraste. A função 

logarítmica tem forma semelhante à função gama que é usada para converter a resposta de 

registro linear dos sensores tipo CCD para uma curva mais próxima da visão humana que não 

é linear (Wyszecki, 1982) mas tem formato fixo enquanto a gama muda conforme o expoente 

da função. A função logarítmica é do tipo: 

 

g= c * log (1+double(f))                 (2) 

 

em que g é a imagem de saida, c uma constante e f a imagem de entrada. O logaritmo pode ser 

de base 10 ou base 2. Em Matlab após a transformação é preciso converter g para 8 bits 

usando a função im2unit8(mat2gray(g)). 

  A função de aumento de contraste tem a forma (Gonzales et al,2004): 
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                 (3) 

 

em que r é a intensidade da imagem de entrada; s a intensidade da imagem de saida; E 

controla a inclinação da função; m é um valor escolhido de modo que valores menores são 

comprimidos para o escuro e maiores para mais claro. A implementação em Matlab para a 

imagem de I16 (16 bits)  e saida na imagems I8 (8 bits) fica: 

 

          
  

               
                  (4) 

em que a constante eps é um valor muito pequeno para evitar divisão por zero.  

 O Matlab tem disponível ainda a função tonemap para imagens de HDR com sintaxe rgb 

= tonemap(hdr, 'AdjustLightness', [low high],  'AdjustSaturation', [ ], 'NumberOfTiles', [2 2]) 

que também será avaliada neste artigo para a imagem de 16 bits. 

 Um operador tipo global que dá bons resultados com imagens HDR e usa mapeamento 

logarítmico ( Reinhard et al, 2002;  Banterle et al, 2011) é o seguinte: 

 

   
                 

                  
                   (5) 

 

em que as constantes q e k ɛ[1, infinito] são selecionadas conforme o contraste da imagem 

original e a aparência desejada da saida; I16(max) é o valor máximo da luminância ou da 

intensidade registrada. 

   

 3. Resultados e Discussões  

 O recorte foi processado com os programas e com as funções próprias e implementadas 

em Matlab. Outros sub recortes do recorte foram também processados para verificação de 

valores de constantes e outras comparações  mas apenas os resultados com o recorte da Figura 

2 são mostrados. 

   

3.1 Imagens processadas no Envi e Erdas 

 O recorte foi processado no Envi, após retirar os stretches introduzidos automaticamente 

em cada banda, com todas as funções. As funções que  deram bons resultados e semelhantes 

entre si foram Stretch Linear e Square Root. Com  Stretch Linear o resultado é um pouco 

mais escuro e é mostrado na Figura 6.  

 

 
Figura 6. Processado no Envi com Stretch Linear. 

 

 Os processamentos com o Erdas foram realizados com o recorte e com a imagem 

completa e as operações que deram bons resultados foram o Min-Max, DynamicRange e 

Linear. Os dois primeiros o resultado é bastante similar ao Envi, com ton arroxeado (Figura 

7a) e com o Linear é a saida é mais esverdeada. (Figura 7b) 
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a) 

 
b) 

Figura 7. Resultados do processamento da faixa no Erdas. a) Min-Max e DynamicRange. b) 

Linear 

 

3.2 Imagens processadas no MatLab 

 O recorte foi processado no Matlab com as funções existentes e com as implementadas. 

Com a função tonemap o resultado está na Figura 8. Com as funções encadeadas I8= 

im2uint8(mat2gray(I16)) o resultado está na Figura 9. A equação 4 foi aplicada com as 

constantes m=200 e E=20 e o resultado está na Figura 10. A equação logarítmica 2 foi 

implementada usando log10 e log2 seguida das outras funções de conversão para 8 bits e 

aumento de contraste (m=250, E= 10 ) com a sequência: Ilog=log(c+ double(I16)); Ilog8= 

im2uint8(mat2gray(Ilog)); I8=1./(1+(m./(double(Ilog8)+ eps)).^E) e resultado mostrado na 

Figura 11. A alteração de log2 para log10 na equação 2 dá resultados similares, apenas os 

valores das constantes m, E mudam conforme sejam os contrastes e formas dos histogramas 

RGB da imagem original. São necessários alguns testes para encontrar os valores adequados 

ao resultado desejado. Com valores inadequados as imagens resultantes variam do branco ao 

preto. Usando a equação 5 implementada em Matlab com as constantes q=0.01 e k=1.0 

resultou na Figura 12. 

 

 

. 

 
Figura 8. Resultado com a função tonemap do Matlab. 
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Figura 9. Resultado com as funções im2uint8(mat2gray(I16)) do Matlab. 

 

 
Figura 10. Resultado com a equação 4 no Matlab. 

 

 
Figura 11. Resultado com a equação logarítmica 2 no Matlab. 

 

 
Figura 12. Resultado com a equação 5 (operador global de Reinhard) no Matlab. 

 

4. Discussão dos Resultados 

 Ao usar as funções adequadas existentes no programas Envi e Erdas a aparência de 

imagens de 16 bits passa a ter intensidade mais uniforme entre as áreas claras e escuras 

(Figuras 6 e 7). O processamento pode ser aplicado apenas para visualização durante os 

trabalhos ou para gerar imagem de 8 bits. Uma opção para quem não disponha do Envi ou 

Erdas é usar o visualizador ER Viewer. 

 No Matlab a pronta im2uint8(mat2gray(I16)) e a implementada equação logarítmica 2 

têm resultados similares aos constrastes lineares do Envi e Erdas; enquanto a função tonemap 
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(de imagens HDR) e as implementações das equações 4 e 5 (Operador de Reinhard) resultam 

em imagens com mais contraste. 

 De modo mais geral os processamentos com os ajustes lineares dos programas e algumas 

funções resultaram em imagens escuras com tos arroxeado e pouco contraste, embora os 

detalhes estejam visíveis nas áreas claras e escuras.  

 . 

 5.Conclusões 

 As imagens com alto contraste de 16 bits por pixel por banda dos novos sensores digitais 

na visualização em 8 bits sofrem um ajuste do histograma introduzido automaticamente pelos 

programas de sensoriamento remoto, que podem alterar significativamente as tonalidades 

originais e haver perda de muitos detalhes tanto nas áreas claras, como nas escuras, se não 

forem tomados alguns cuidados de processamento e usando as funções adequadas existentes 

nos programas como Erdas e Envi.  

 Também foram testados algumas funções disponíveis no MatLab e implementadas várias 

outras que funcionaram bem visualização e conversão de imagens de  16 bits para 8 bits.  
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